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TONBRIDGE CAMERA CLUB – COMPETITION RULES 
 

CONTENTS 

 

Items shaded in yellow are new or have been substantially altered for the 2023/2024 season. 

 
Images from “Lockdown” and the 2020-21 season’s “Local” competitions may be reused. 
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9 – 10 Appendix 1 – New Guidelines for preparing and submitting PDIs. Rewritten June 2020; updated May 2022. 

11 – 14  Appendix 2 – PhotoEntry Guide 

15  Appendix 3 – Viewing Images in PhotoEntry Gallery 

15 - 22 Appendices 3A – 3E Resizing images (optional but recommended)  

 
*PDI = Projected Digital Image. PDIs are simply ordinary digital images which are normally viewed on a monitor/iPad, 

etc. but for competition purposes are projected on to a screen. 

 
ISSUING RESULTS 

 

After many competitions, you will be sent an email with an Excel spreadsheet attached showing the results. This will be 
updated after each competition and will include a tab showing current rankings for Open Competitions. 

 

At the beginning of the season, current and returning members will be sent an Excel Results spreadsheet showing the 

titles of all your entries since records began. 
 

Images and results for all competitions from 2013/2014 to 2019/2020 are available in the Members’ area of the website 

with specific links for individual competitions included on a separate tab in the Results spreadsheet. 
 

Competition results from 2020 onwards can be viewed in PhotoEntry. See Appendix 3. 
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SECTION 1: GENERAL RULES  

 

You should be able to save your own copy of these rules. If not, email philip.smithies@hotmail.co.uk who will send a 

copy. The rules can be accessed on the footer of the club website. 
 

1. Competitions are only open to honorary and paid-up members of the club.  

 

2. All images submitted for competitions must have been taken by you on film or with a digital camera i.e. they must originate 

from a photographic process and not from computer-generated graphics. Digital manipulation is accepted (unless otherwise 
stated) provided it’s been done by you. Images produced from materials copyrighted by persons other than you (e.g. the work 

of other photographers) are unacceptable: you must be able to claim the copyright for any image submitted. For example, if 

you use software to replace a sky then the new sky must be one of your images. 

 

3. The final image must be a print or a digital file for projection (Projected Digital Image or PDI). Separate competitions are held 

for both image mediums (prints and PDIs). There are Competition Secretaries for both mediums. 

 

4. Images may be colour, monochrome, infra-red or (for example) sepia unless otherwise stated in individual competition rules. 

 

5. Except as specified below, images, or “near duplicates” of images, accepted for Tonbridge Camera Club competitions cannot 

be reused. For example: 

• Any image submitted in a particular medium in one competition may not subsequently be submitted into a different 

competition in a different medium e.g. an image entered in one competition as a print may not then be entered into another 

competition as a PDI. 

• Digitally manipulated versions (including colour to monochrome) of previously entered images are not allowed.  

• An image which is so similar to one previously submitted by the same member as to be almost indistinguishable from it 

will not be allowed. 

• In the interests of healthy competition, you should aim to follow the spirit of the rules and not submit similar images as 

different entries. 

• Please talk to the PhotoEntry Administrator(s) before the competition if you’re unsure about the suitability of an image. 

 

6. Any competition which in a given season attracts entries from three people or fewer will not be run. 
 

7. Images submitted for internal competitions will be deemed to be available for use on the club website and/or PhotoEntry 

galleries and/or external competitions and/or the Annual Reports and/or internal AVs unless otherwise advised by email to the 

PhotoEntry Administrators. Any such restriction should be notified at the time that the image is first entered for an internal 

competition. 

 

8. Closing dates for submission of entries are described below. They are normally on the Thursday before the competition. 

 

9. On competition evenings, each entry is shown in turn, and the title is read out. The judge then makes his/her comments. A 

mark out of 20 is awarded and only then is the photographer's name revealed. For certain competitions, judges will additionally 

be asked to select first, second and third place entries. Images must not contain any reference to the photographer’s name. 
 

10. Whilst every care will be taken, the club can’t accept any responsibility for loss or damage to material(s) entered for 

competitions or exhibitions. 

 

11. To ensure smooth running of competitions, the Committee reserves the right to make minor changes to these rules at any time, 

but will ensure that the membership is advised. 

 

12. Any image which does not conform to competition rules will be liable to disqualification. 

 

13. Trophy winners are responsible for returning their cleaned trophies promptly when requested. 

 

14. The Committee's decision will be final regarding all matters relating to the interpretation of these rules. 
 

15. Entrants are deemed to have read and accepted the rules and conditions in this document. 

mailto:philip.smithies@hotmail.co.uk
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SECTION 2: THE COMPETITIONS  
 

The following competitions are held each season: 

a) A four-round    ‘Open Subject’ competition. P  D   see Sections 4 and 5 

b) A single-round ‘Record’ competition.  P  D   see Section 6.1 6.1 

c) A single-round ‘Portrait’ competition.  P  D   see Section 6.2 

d) A single-round ‘Natural History’ competition. P  D   see Section 6.3 

e) A single round “Scapes” competition  P  D P    see Section 6.4 

f) A single-round ‘Panel of Prints’ competition. P see Section 6.5 
g) A single-round ‘PDI Sequence’ competition. P  D   see Section 6.6 

h) A single-round ‘Small Print’ competition.  P see Section 6.7 

i) A single-round ‘Print of the Year’ competition. P see Section 6.8 

j) A single-round ‘PDI of the Year’ competition.     D   see Section 6.9 

k) The Outing Competition will not be held in the 2023/2024 season  
 

Notes: 

1. Further details and the full rules for all competitions can be found below. 

2. Trophies for these competitions are awarded annually and held for one year. 

3. There is an award for the ‘Photographer of the Year’. See Section 6.10 for details. 

4. Competitions organized and administered by the AV subgroup are open to all members. 

N.B. The dates in PhotoEntry will always be more up-to-date than those in the table below. Always check dates in PhotoEntry 

for absolute accuracy. 
Competition Competition Date (Thurs) Submission date (Thursdays) 

Print Open Round #1 (changed on 11/07) September 21st 2023 September 14th 2023   P    

PDI Open Round #1 (changed on 11/07) October 12th 2023  October 5th 2023        D   

PDI Open Round #2 October 26th 2023  October 19th 2023        D 

Record November 9th 2023  November 2nd 2023    P  D   

Print Open Round #2 November 23rd 2023 November 16th 2023   P   

Portrait November 30th 2023 November 23rd 2023   P  D   

Small Print November 30th 2023  Just bring them in on the night of the competition P   

PDI Open Round #3 January 11th 2024 January 4th 2024        D 

Print Open Round #3 January 25th 2024 January18th 2024    P   

Print Open Round #4 (changed 23/07) Feb 22nd 2024 Feb 15th 2024    P   

Print “Theme Round #4: Simplicity” (changed 23/07)  Feb 22nd 2024 Feb 15th 2024    P   

Scapes February 29th 2024 February 22nd 2024    P  D   

PDI Sequence March 7th 2024 February 29th 2024        D 

Print Panel March 7th 2024 March 6th (day before the competition)   P   

PDI Open Round #4 (changed 23/07) March 21st 2024 March 14th 2024        D 

PDI “Theme Round #4: Lines” (changed 23/07) March 21st 2024 March 14th 2024        D 

Natural History April 25th 2024 April 18th 2024    P  D    

Print & PDI of the Year May 2nd 2024 April 25th 2024    P  D    

Exhibition   TBC     P  D 

 

The Annual Exhibition is quite separate from club competitions. See Section 7. 

 

SECTION 3: IMAGE MEDIA RULES 
 

3.1 GENERAL FOR BOTH PDIs and PRINTS  P  D 
 

All images for both PDIs and Prints must be registered/submitted online to the PhotoEntry website at 

https://compent.photoentry.uk/compent/. You MUST read the separate “PhotoEntry User Guide” (Appendix 2) to understand fully 

how it works. When using PhotoEntry, please note that file names are limited by the software to FIFTY characters comprising 

alphanumeric, space, and the characters ,.!'-%(). Note that many standard symbols are not allowed by the software and that very often 

permissible non-standard symbols cannot be the first character in a name. If the name turns red when you enter it, you have used a 
symbol incorrectly. 

 
Before entering competitions, make sure you read every part of Appendix 1. 

 

Before entering prints, make sure you also read Sections 3.3 and 3.4.  

 

If you wish to enter competitions but haven’t yet used PhotoEntry, you need to contact one of the PhotoEntry Administrators 

(currently Philip Smithies philip.smithies@hotmail.co.uk, Pam Sherren psherren@zoho.com or Philip Easom 

preasom@btinternet.com ) who will send you log-in details for PhotoEntry. 
 

P = Print  

D = PDI  

 

https://compent.photoentry.uk/compent/
mailto:Philip.smithies@hotmail.co.uk
mailto:psherren@zoho.com
mailto:preasom@btinternet.com
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3.2 RULES FOR PDIs     D 
Rules for PDIs are set out in Appendix 1. Note that we use a resolution of 1920 x 1200 to match the projector’s resolution. PhotoEntry 
can resize images. 

 

3.3 and 3.4 RULES FOR PRINTS  P 

 

NOTE: There are very significant changes, additions and clarifications to the Print Guidelines and it is ESSENTIAL that you read 

very carefully the whole of this page as well as the “PhotoEntry User Guide”. 

 

3.3 Preparing Prints 

a. Prints must be produced under your total control or direction. It is absolutely fine to have images commercially printed and to 

use commercial mounts and/or to have the print commercially mounted. 

b. Each print must be mounted or placed directly on the mount. The mount itself must be EITHER 50cm wide x 40cm high OR 
40cm wide x 50cm high. Note: smaller mounts may be used for the Print Panel Competition and for the Small Print 

Competitions only. 

c. The print itself may be of any size that fits within or on the mount except for the “Small Print” Competition where the image 

must be no greater than 15cm x 15cm.  

d. Make sure that your entries will not cause damage to other entries e.g., don’t use Velcro type strips on mounts, or leave exposed 

sticky tape. 

e. Ensure prints are stuck down properly. 

f. Please consider putting a backing on your prints. Without this, they tend to be floppy and spoil the viewing 

3.4 Submitting Prints 

a. Upload a PDI version of your print images to PhotoEntry as if you’re entering a PDI competition. For competitions other than 
“Small Print” and “Print Panel”, the deadline is midnight of the Thursday of the week preceding the competition (see page 3). 

b. The Print Secretaries will then decide on the running order and will allocate a number to each print. You will be advised of print 

numbers by email. 

c. On the evening of the competition, bring in your prints by 7.15 p.m. When you arrive at the meeting, write on the “post-it” note 

provided (these will be smaller than previous years) the number(s) allocated by the Print Secretary for the specific competition 

and place it on the FRONT of each print in the TOP LEFT-HAND CORNER as shown below. The Print Secretary will indicate 

where you should place your print on the stands to ensure they are in numerical order. 

d. The printed list of titles, with a column for marks, will be made available for the announcer. Images and marks will be available 

on the PhotoEntry website soon after the competition. 

e. You are responsible for bringing in your prints and taking them home on the day of the competition, or for arranging for another 

member to do so on your behalf. Prints will no longer be stored at the school or by the Print Secretaries. 

 
The reasons for these changes are: 

1. To relieve pressure on the Print Secretaries who will no longer have to take home heavy boxes of prints, bring them back to the club two weeks later and try to 

store uncollected items. They will not have to spend time generating lists of entries as PhotoEntry does this automatically. 

2. To reduce the risk of damage to prints. 

3. To relieve pressure on entrants who will now only bring prints in and take them home on the day of the competition. 

4. To reduce the deadline for submission of prints from 14 days to just 7 days before the competition. 

5. To enable entrants to change their minds up to seven days before the competition. 

6. To enable results to be issued semi-automatically from PhotoEntry. 

7. To enable galleries of images to be produced automatically in PhotoEntry. 

8. To build up an easily accessible bank of images for selection for external competitions. 

9. To encourage the submission of prints. 

Note: The judging will only be based upon the printed image and the judge will not see the PhotoEntry gallery. 

 

 

      
       FRONT OF PRINT                FRONT OF PRINT 

 

 

50cm 

50cm 40cm 

Note:  
The ONLY information required on 
the print is the number allocated as in 
3.4 above which should be entered on 

the top-left of the front of the print. 
 
There is no longer any need to enter 
any information on the back of the 
print for internal competitions 
(although see 6.4) 

40cm 

Number 
Number 
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SECTION 4: COMPETITION GROUPS  P  D   

Currently, for all competitions whether Open (Section 5) or subject-specific (Section 6), there is only one group (Group A) to which 
everyone is allocated. Members compete on an equal basis. 

However, if you are new to photography or regard yourself as inexperienced, feel free to enter (I) AFTER the title when submitting 

your entries via PhotoEntry. This will ensure you receive feedback from the judges which is more suitable to your level of experience 

(for example containing more practical advice). Note that you won’t receive any special allowance with the mark itself. 

 

SECTION 5: OPEN SUBJECT COMPETITIONS P  D 

1 A competition, consisting of FOUR rounds, is held for both image mediums. One part of the final round (Round 4) will be 

subject-specific. For Prints, the subject will be “Simplicity”; for PDIs the subject will be “Lines”. In Round 4, therefore, you 

can enter ONE themed image and ONE normal image. 

2 You may enter as many or as few rounds as you choose. However, to be eligible for an Open Competition Award (see below) 

you must have submitted a minimum of seven images.  
3 You may enter up to two images (either monochrome or colour) of any subject (except the subject-specific round as mentioned 

above) per medium in each round.  

4 Each image is marked out of 20. 

5 Trophy winners in each group, for each medium, are described below. 
 

OPEN SUBJECT COMPETITION AWARDS 

 
For both mediums, the following trophies and certificates are normally awarded:  

• The Founder's Cup (Prints) / Newman Trophy (PDIs). Members will be ranked in each medium in order of the aggregate score 

of the best SIX marks gained in all four of the rounds, with marks from the seventh highest entry being considered in the event 

of a tie. If there is still a tie, the eighth highest mark will be taken into account. 

• A trophy for the best new member (only available for members in their first year of eligibility). 

• A trophy for the most improved member (not available for members in their first year of entry and only awarded once to any 

individual). 

• A certificate for the member with the highest aggregate score. 

See also "Photographer of the Year Award".  

 

SECTION 6: OTHER COMPETITIONS 

 
6.1 – 6.4: RECORD, PORTRAIT, NATURAL HISTORY and SCAPES COMPETITIONS – GENERAL POINTS: 

1 For each of the Record, Portrait, Natural History and Scapes competitions, there are individual competitions for Prints and PDIs. 

2 Members may enter up to three images for each medium. 

3 A trophy, to be held for one year, will be awarded to the member achieving the highest aggregate score in each of the 

competitions. In the event of a tie, the trophy will be shared. 

4 Images already used in the Open Subject Competitions may not be entered in these competitions. However, individual entries 

from these competitions may afterwards be entered in Open Subject Competitions on one occasion only. 

 

6.1 RECORD COMPETITIONS   P  D  (m 

 

“Record Photography” is the photography of inanimate objects including all man-made structures or artefacts including (but not 
restricted to) archaeological and architectural objects and details, historical artefacts, stained glass, statues, glassware, porcelain, 

ornaments, and mechanical devices. Subject matter not allowed includes Natural History and images which rely strongly on a pictorial 

element, such as landscapes and portraits. 

 

The resulting image should be an accurate representation with detail visible in the full range of tones with an absence of digital noise 

and in as informative a manner as possible. It should be in sharp focus with no converging verticals or other distortion (for example 

lens distortion). It should accurately show shape, detail, form, colour and texture, so that it would help to recreate the subject in the 

event of it being damaged or stolen. Artistic interpretation is important provided it does not adversely affect the accurate recording of 

the subject in question. Appropriate lighting is essential to show details, colour and texture. 

 

There are no restrictions to the techniques that you may use to record or process an image. However, the emphasis must be placed on 
accurately conveying information about the structure, function and/or appearance of the subject. 

 

Individual file names should be factual – creative titles are unsuitable for this category. You can provide additional written 

information about each of your entries which will be read out as the image is shown. This information might include, for example, the 

subject’s identity, location, size, age, construction materials, designer, builder, etc. as appropriate. Most people don’t bother. 

 

6.2 PORTRAIT COMPETITIONS   P  D 

 

A portrait is a picture whose main content is the human (not animal) form. Images may consist of one or more individuals and they 

can have been taken in any setting e.g., candid/ “street” and formal “studio”.   

There are no restrictions in the techniques that you may use. 
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6.3 NATURAL HISTORY COMPETITIONS  P  D 

 
The rules for the Natural History Competition have caused a great deal of confusion over the last few years and what follows is a 

rephrased version in an attempt to improve clarity. 

 
The rules, created a few years ago, were based on those for Nature and/or Natural History photography adopted by the International, National and 
Regional photographic governing bodies and the wider photographic community e.g., FIAP/PSA/RPS/PAGB/KCPA. However, their definitions may 

change over time (sometimes significantly) so if you are thinking of entering such competitions, you should check their rules very carefully. 

 
Natural History means images where living organisms (including marine and botanical subjects as well as fungi and algae) are the 

primary subject matter and presented in such a way that a well-informed person will be able to identify the subject material and certify 

its honest presentation. The story telling value of an image will normally be weighed more than the pictorial quality although high 

technical quality is very important. Images which are also allowed include those taken with subjects in controlled conditions such as 

zoos, game parks, botanic gardens, aquariums and enclosures where the subjects are dependent on humans for food. Scientific bands, 

tags or collars on wild animals are permissible. 

The following are NOT allowed: 

• Images where the subjects are obviously domestic or hybrid animals or plants. 

• Images of feral animals 

• Images of mounted specimens 

• Images where an obviously artistic treatment has been applied. 

• Images which are “stitched” 

• Infra-red images 

Human elements must not be present unless they form an integral part of the nature story e.g., where animals such as barn owls or 

foxes have adapted to an environment modified by humans. 

 

Although a range of photographic techniques are allowed*, the overriding principle is that such manipulation should enhance the 

presentation of the images but not detract from their truthfulness. 

(*specifically including exposure adjustment, colour correction, noise removal, dodging/burning, HDR, focus stacking, removal of 

minor distractions (for example by cloning) and sharpening as well as the removal of defects added by the camera such as dust spots, 

digital noise, and film scratches.) 

 
The use of binomial Latin names of subjects is not mandatory but appreciated by judges. 

 

6.4  SCAPES COMPETITIONS 

 

A ‘scape’ image shows a vista including, but not restricted to, landscapes, cityscapes and townscapes, seascapes, waterscapes and 

skyscapes. Whilst these images may include trees, animals, people, *buildings (and other artefacts), these must not dominate the 

image and only form a very small part of it: the primary focus of the photography must be scenery in order to be considered a Scape.  

There are no restrictions in the techniques that you may use. 

*An individual building does not qualify as a Scape whereas (for example) a row of buildings on a river front would be allowed. 

 

6.5 PANEL OF PRINTS COMPETITION P 

 
 

 

 

 

 
 

 

 

 

1. This is for a panel of prints exhibiting a unifying theme, the interpretation of which is left to you.  

2. You may enter only one panel which must be brought in on the night of the competition.  

3. Please upload to PhotoEntry a jpeg of the “Display Plan” by the night before the competition at 

the very latest. The title should be that of the entire panel. Consult the PhotoEntry Coordinator if 
you’re not sure how to do this. If you prefer, one of us can prepare it for you. 

4. Panels may consist of up to six mounts. More than one print may be included in each mount. The 

whole panel must be able to be displayed in two or three rows on the club's display stand. 

5. The rules in section 3.1 above for Print images apply individual although mounts can be any size 

up to and including 50cm x 40cm. (Note: judges seem to prefer 50x40/40x50 mounts) 

6. A “Display Plan” (as in the diagram opposite) must be handed to the Print Secretary on the night 

of the competition. It should also be uploaded to PhotoEntry as described above. You may 

provide a short description of the panels and/or of individual prints. These would be read out by 

the Announcer at the appropriate points. 

7. Marks out of 20 will be awarded. In the event of a tie, the member whose panel is judged the 

best will receive the Norman Denman Cup, to be held for one year. We also often ask for 2nd 

and 3rd places to be awarded. 
8. Images previously entered in TCC competitions are ineligible. However, individual prints from 

the panel may afterwards be entered once in open competitions. 
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6.6 PDI SEQUENCE COMPETITION  D 

The rules below reflect the changes made to previous seasons’ competition. 
This is for a single PDI sequence (one sequence per member) containing between four and six images which displays a coherent 

theme (e.g. with a story-telling aspect) with the images to be projected one after the other.  

1. Each image can be resized as described in Appendix 4 but doesn’t have to be 

2. There must be an overall title for the sequence and individual titles for each image.  

3. OPTIONAL You may if you wish provide a short description for the sequence and/or short descriptions for each individual 

image which will be displayed or read out by the Announcer at the appropriate time. Send this information to the PDI 

Secretary when you enter your images. Most people don’t bother. 

4. The usual PhotoEntry rules for filenames apply i.e. TITLE only.  

5. A linear montage (filename is the same as the overall sequence title), produced by either the competition organisers or by 

you, will be shown at the competition to act solely as an “aide-memoire” for the judge. This will be numbered “1” in the 

sequence. It will also be included as the final entry – no. 8 if you enter six images. 
 

To summarise with an example for a sequence whose overall title is “EMOTION” and composed of SIX individual images: 

EMOTION  (a linear montage prepared by EITHER the organisers OR by you with the sequence title) 

RAGE  (your first image) 

CALM  (your second image) 

PEACE  (your third image) 

HOPE  (your fourth image) 

SADNESS  (your fifth image) 

ELATION  (your seventh images) 

EMOTION  (a linear montage prepared by EITHER the organisers OR by you with the sequence title) 

 

• Images previously entered in TCC competitions are ineligible. However, individual images from the sequence may afterwards 
be entered once in open competitions. 

• Marks out of 20 will be awarded. In the event of a tie, the member whose sequence is judged the best will receive a trophy, to 

be held for one year.  We also often ask for 2nd and 3rd places to be awarded. 

• Ideally, please submit entries TWO weeks before the date of competition in order to enable the linear montage of images to be 

prepared. 

 

 CLUB ANNUAL OUTING COMPETITIONS P  D 

Not held in 2023/24 as the Annual Outing did not take place. 

 

6.7 SMALL PRINT COMPETITION  P 

 
1. This is an open subject competition for prints with a maximum dimension of 15cm on the longest side.  

2. A maximum of two prints per entrant are allowed. 

3. Mounts themselves can be any size up to and including 50cm x 40cm. 

4. Images previously entered in any TCC competition are ineligible. 

5. Entries from this competition may afterwards be entered once in open competitions (but in each case in the image must be in 

or on the standard-sized mount). 

6. First, second and third places are awarded (based on one image). The member whose print is judged the best will receive the 

Small Print Trophy (to be held for one year). 

7. This competition normally takes place on the same evening as the Portrait Competitions and is judged during the break. 
 

6.8 PRINT OF THE YEAR COMPETITION  P 

 

You may enter TWO prints selected from your entries in any of the previous twelve months’ print competitions, or from the current 

year’s exhibition entries. If entry numbers are high, it may only be possible to use one print so you must indicate your first choice and 
your second choice. Entries will be awarded marks out of 20. In the event of a tie, the judge will be asked to select 3rd, 2nd and 1st 

places with the latter being awarded the Brother UK Shield (to be held for one year). 

 

 

 

6.9 PDI OF THE YEAR COMPETITION  D 

 

You may enter TWO PDIs selected from your entries in any of the previous twelve months’ PDI competitions or from the current 

year’s exhibition entries. If entry numbers are high, it may only be possible to use one PDI so you must indicate your first choice and 

your second choice. Entries will be awarded marks out of 20. In the event of a tie, the judge will be asked to select 3rd, 2nd and 1st 

places with the latter being awarded a trophy (to be held for one year). 
 

NOTE: for both PDI and Print of the Year Competitions, there must be no “media-switching” i.e. an image which was judged as a 

PDI cannot then be entered as a print and vice-versa. 
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6.10 PHOTOGRAPHER OF THE YEAR AWARD  P  D 

 

This is awarded to the person who attains the highest aggregate mark for all entries in the Open Subject Print Competition Rounds and 

Open Subject PDI Competition Rounds giving a maximum score of 320 from FOUR rounds PLUS all of the marks in each of the 

Portrait, Record, Natural History and Scapes (Prints and PDIs) competitions, giving a maximum score from these competitions of 480 

and an overall maximum score of 800. Everyone is automatically eligible.  

 

7 ANNUAL EXHIBITION    P  D 
 

This is an open exhibition and NOT a competition.The dates for the submission of entries have not yet been confirmed but the 

exhibition itself will take place at the Royal Tunbridge Wells Arts Society building in the Pantiles on the final weekend in October 

with setting-up taking place on the weekend before.  

Conditions of Entry 

 

1. The Exhibition is quite independent of club competitions. 

2. Any image may be submitted provided it hasn’t been accepted in a previous exhibition. 

3. All TCC members may enter. You are guaranteed to have at least one image accepted in each medium. 

4. You may submit up to three prints and/or three PDIs. It is your responsibility to supply frames for prints which have been 

accepted. 

5. Prints must be mounted – and NOT placed directly on the surface of the mounting board. The mounts must be EITHER 

50cm wide x 40cm high OR 40cm wide x 50cm high. 

6. The three PDIs should be sent to philip.smithies@hotmail.co.uk at a resolution of 1920 x 1080 with the file name: TITLE by 

Author (TITLE = UPPER CASE; by = lower case; Author = Mixed Case)  

7. Duplicates or near duplicates (as defined in Section 1.6) of images previously accepted in a Tonbridge Camera Club 
Exhibition are not eligible. 

8. Entries must be prepared as described above and in the Appendices  

9. The arrangements for submitting entries will be issued nearer the time. 

10. The Club cannot accept responsibility for damage to members’ work. 

 

mailto:Philip.smithies@hotmail.co.uk
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APPENDIX 1 – PDI GUIDELINES 

• Submitting images 

• EXIF data 

• Setting colour space (optional) 

• Naming images 

• Resizing images (optional) 

• Adding a border/stroke 

• Changing background colour 
 

IMPORTANT: MAKE A COPY OF THE IMAGE YOU INTEND TO USE. When you have resized, saved and closed the image, 

the process cannot be reversed. Always work on a copy of the image. 
 

SUBMITTING IMAGES 

On-line using PhotoEntry. See “PhotoEntry User Guide” which has been modified since it was first issued (Appendix 2). 

 
EXIF DATA 

PhotoEntry does not remove EXIF data except when it creates thumbnails and Viewing Galleries. As it is too time-consuming for the 

PDI Secretary to remove it, you may therefore prefer to remove it yourself before you upload your images although the overwhelming 

majority of entrants don’t bother and there is no necessity to do so. 

Once EXIF data is removed, it cannot be restored. 

The club website automatically removes EXIF data. 
 

SETTING THE COLOUR SPACE (optional) 
 

sRGB (not Adobe RGB) is the preferred setting as this is what external PDI competitions insist on. If your entry were to be selected 

for an external competition, the External PDI secretaries may well ask you to ensure that sRGB is chosen. That said, the club projector 

is set up in such a way so that whatever colour space you use, the image will be projected to show it at its best. 

 

    
Note: PhotoEntry will “warn” you if the Colour Space is not sRGB. Unfortunately, it cannot be configured to remove this warning. It 

is therefore suggested that you simply ignore it. 
 

NAMING IMAGES 

 

• The title must be in upper-case although PhotoEntry automatically corrects any in lower-case or mixed-case. 

• The title must NOT contain the word “by”. 

• The title must NOT include your name. 

• PhotoEntry will reject any titles which contain characters forbidden in Windows filenames (i.e. \ / : * ? ” < > | ).  

• Don’t add (for example) 1 of 2 or 2 of 2 to the title. You can easily order your images in PhotoEntry 

• Only JPEGs are accepted and therefore the extension must be .jpg/.jpeg or .JPG/.JPEG. Consult your computer’s “Help” section 

if you can’t see the extension in any of your folders (enter “view extension” in the search box). 
 

RESIZING IMAGES  

 

Images are projected at a size of 1920 pixels wide by 1200 pixels high (in a 16:10 ratio) and ideally should be resized accordingly. 

The width must not exceed 1920 pixels and the height must not exceed 1200 pixels. The projection software will automatically place 

a black background around any image with a ratio other than 16:10 so please do NOT add black backgrounds. 

 

However, with the introduction of PhotoEntry, it is no longer compulsory to resize images (although we recommend it) as the 

software will do it for you. SEE APPENDIX 4 FOR FOUR WAYS OF RESIZING IMAGES 
 

To specify/check the Colour Space in Photoshop, select Edit→Assign Profile. 

 
This box appears: 

 
 
Click “Profile” and choose “sRGB” from the drop-down list. 

Note: When this box opens, you may well find that sRGB is already selected. If this is 

the case, simply click “Cancel”. 
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ADDING A BORDER (STROKE) (optional) 
 

If you wish to add a border (stroke, as Photoshop calls it), consult your software guides or go on-line for further information. A border 

may be added before or after resizing and there are a variety of ways are doing this. Depending on the method you choose, you would 

need to ensure that you haven’t removed a critical part of the outside of the image or increased the dimensions of the image beyond 

the acceptable size. 
 

BACKGROUND COLOUR 

 

The overwhelming majority of people leave the background colour as black for those images which are not exactly 1920 x 1200 

pixels.  

Please DON’T add black backgrounds by extending the canvas size: there is no need to do so and it subsequently involves 

extra work for the competition secretaries, exhibition organisers and webmasters. 

 

SPELL-CHECK 

 

Before submitting your image, consider using a spell-check on the title to eliminate typos. You can see for yourself in the competition 

results on the website numerous examples of spelling mistakes – although we do try to correct them – and judges often draw attention 

to them. 

Some words seem to be regularly spelt wrong e.g. BODIAM (not Bodium) and ALTAR (as in a church – not ALTER). Perhaps the 

most memorable example of bad spelling was “The Chaple of the Royle Navel Collage”. 

 

JUDGING 

This article by Roger Wates on the subject of judging (How to reduce judges’ criticisms) is available on the website in the Members’ 

Area: https://docs.wixstatic.com/ugd/946144_ad19d9fc6f4d4887bba52268de1cc496.pdf  

 

This is link to a lengthy but interesting collection of articles about judging: 

http://www.pagbnews.co.uk/sites/default/files/newsletters/en105271213_JudgingSpecial.pdf 

https://docs.wixstatic.com/ugd/946144_ad19d9fc6f4d4887bba52268de1cc496.pdf
http://www.pagbnews.co.uk/sites/default/files/newsletters/en105271213_JudgingSpecial.pdf


Page 11 of 21 TCC COMPETITION RULES This version updated Summer 2023 by Philip Smithies 

 

APPENDIX  2 – PHOTOENTRY USER GUIDE  

 
When you email the PhotoEntry Administrators (currently philip.smithies@hotmail.co.uk and psherren@zoho.com ) that you wish to 

enter competitions, your name and email address will be entered into PhotoEntry and you will receive an automatically generated 

standard email (it may possibly go to your junk mail so check there). 

 
Fig 00 

To stop important messages going to junk: 

1 right-click on the message 

2 in the menu that appears, left-click “Junk” and select the most appropriate option (usually “Not Junk” or “Never block 

sender”). 

3 This usually works for future occasions – but not always. Periodically check your junk emails. 

4 Move the email to the normal in-box. 

 

NOTE: Fig 00 is a Microsoft Outlook screenshot. Your screenshot may not look the same and may have different options for handling 
junk emails. 

 

 
Fig 01. 

In the email addressed to you (possibly with your surname first depending on how the software is configured), you’ll see a link (URL) 

to the PhotoEntry site, a User ID (your email address) and a temporary password. 

Click on the URL link. 

URL 

User ID 

Temporary 

password 

mailto:philip.smithies@hotmail.co.uk
mailto:psherren@zoho.com
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Fig 02 

 

 
Fig 03 (this will only appear the first time you use the software) 

 

 
Fig 04  

On the left are a number of links including the club’s website and Facebook page as well as a “Help” guide. 

Navigate to the correct competition and click. 

Consider adding the URL to your “Favourites”: https://compent.photoentry.uk/compent/ 

1 On the web-page that 

appears, the User ID will 

already be there. DON’T 

CHANGE IT 

2 Enter the password that was 

in the email in Fig 01. You can 
copy and paste it from the 

email. 

3 Tick “Remember User ID on 

this computer” 

4 Click “Login” 

 

1 Enter a NEW password of your 

choice 

2 Re-enter the password 

3 Click “Change Password” 
 

You may be offered the choice of 

allowing your machine to 

remember your password. 

 

https://compent.photoentry.uk/compent/
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Fig 05 

1 Click on the name of the competition. You will only be able to enter the competition if the Status is “Open”. 

2 When you revisit the page, you can see/modify your entries here 

 

 
Fig 06 

A screen with information about the competition appears.  

Click on “Add New Entry”  

 
NOTE: RESIZING IMAGES  

It is no longer compulsory to resize your images as PhotoEntry software will do it for you although we suggest you should consider it. 

Read Appendix 4A below for more information based on that given in PhotoEntry’s “Help” section. 

 

Every internal competition will be configured with the projector’s “Target Dimensions” of 1920 x 1200.  

 

If you want to resize your images but don’t have any photo-editing software, read Appendices 4B (A simple and free way to resize 

images online without using software) and/or 4C (A simple and free way to resize images using Microsoft’s “Photos” App). If you 

have Photoshop, read Appendices 4D and 4E. 
 

 
(Continued on next page) 



Page 14 of 21 TCC COMPETITION RULES This version updated Summer 2023 by Philip Smithies 

 

 
Fig 07 

 

 
Fig 08 

Note: PhotoEntry will “warn” you if the Colour Space is not sRGB. Unfortunately, it cannot yet be configured to remove this 

warning. Just ignore it. 

 

This screen now appears. 

 
Fig 09 

 

Finally, if you haven’t already done so, add the URL to your favourites: https://compent.photoentry.uk/compent/ 
Log Out when you’ve finished your session 

See the next pages for important notes on how to view competitions and how to resize. 

 

 
 

1 You will be warned of any problems – 

in this case, the image was too small but 

the software had not been configured to 

automatically reject it. 

2 If you don’t understand an error 

message, check “Help” first before 

contacting the competition organiser. 

3 You can investigate Actions here (e.g. 

deleting or renaming the image, 

rearranging the order, etc.) 

4 You can add further images here up to 

the maximum allowed. 

1 Enter the title – UPPER CASE 

ONLY. The software automatically 

corrects titles in lower or mixed case. 

DON’T include your name or the 
word BY. 

2 If you want to make brief notes to 

remind you of something, do so here. 

3 Further non-relevant options. 

4 Click “Add This Entry”.  

Note: the actual uploading of the 

image comes next 

 

1 Click “Choose JPEG”, navigate to 

the correct folder and image and click 
“Open”.  

2 The name will appear below the 

“Choose JPEG…” box 

3 Click “Upload Image”. The image 

will upload but this may take a few 

seconds (the status may appear at the 

bottom of your screen). 

4 You will be warned of major errors. 

Check “Help” for more advice. 

https://compent.photoentry.uk/compent/
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APPENDIX 3: VIEWING COMPETITION RESULTS 

VIEWING EVERYONE’S ENTRIES AND MARKS FOR A JUDGED COMPETITION 

To view the results and image gallery of a single competition: 

1 Log-in to PhotoEntry 

2 Click on the relevant judged competition 

 
4 Between the data list and the thumbnails of your individual entries you’ll see “View Entries for All Users”. Click on this. 

 
5 By the words "Class: Club Group A", click on “View xxx entries” 
6 The images will appear in numerical order from 20 downwards. The marks and authors' names are in a box underneath 

labelled “Entry Notes” and/or by the title. 

7 Use the arrow keys to navigate through the gallery. 

8 Click on the image to view it full-screen. Click on the image again to return to the normal screen. 

9 When you’ve finished, click “Exit Viewing” on the top right. 

VIEWING ALL YOUR INDIVIDUAL ENTRIES FOR A SEASON 

To see ALL your individual entries and marks from an entire season, click on (for example) “2022-23 TCC Competitions” and then 

'Show your entries in this Group'. Clicking on the individual image enables you see it full-screen. 

 
APPENDIX 4A: DO I NEED TO RESIZE IMAGES? 

 

In a word: NO … but read the rest of this page 

Always check the required dimensions shown on the image upload screen. They will almost invariably be 1920 x 1200. 

 

• DiCentra, the projection software we often use, prefers images to be sized correctly, and has been known to display images in a 

less than desirable way if they are not.  

• To be absolutely sure that your image is displayed in the best form, you should resize the image before uploading it (as described 

in Appendices 4B to 4E). However, PhotoEntry will do an excellent job of resizing it (retaining the same aspect ratio) for you if 

necessary, although the best results will only be obtained if the uploaded image is substantially larger than the required 

dimensions. For example, if 1920 x 1200 target dimensions are specified, submitting a 1940 x 1237 image will not yield a good 
result, but submitting (for example) a 3800 x 2400 image will be quite acceptable. Clicking on the thumbnail will show the resized 

image for you to check. Downsizing always gives better results than upsizing. 

• A warning will be triggered if the target dimensions are not met. Depending on how the competition rules are configured, the 

software may reject your image and tell you to resubmit. 

• A very common mistake is to resize for the long side. The size requirements specify a maximum width of 1920 and a maximum 

height of 1200. This is NOT the same as specifying a height of 1920 and a width of 1200.  

• A “LANDSCAPE” format is one in which the width is greater than the height; a “PORTRAIT” format is one in which the height 

is greater than the width. (1920 x 1200 is also, of course, a landscape format). 

• If the image is larger than 10MB, PhotoEntry will reject it. 

• If you’re happy to let PhotoEntry resize your images, don’t bother reading the rest of this document. 
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APPENDICES 4B – 4E: HOW TO RESIZE IMAGES 

 
4B: A SIMPLE AND FREE WAY TO RESIZE IMAGES ONLINE WITHOUT USING SOFTWARE 

ALWAYS WORK ON A COPY OF THE ORIGINAL IMAGE 

 

Go to: https://picresize.com/  (there are other similar sites) 

 
 
FIG 10 

Drag an image here (or use the “From Computer” route) – this can be quite slow, depending on the size of the image. Then click 

“Continue to edit picture” 

 
FIG 11 

Don’t worry that only part of the image is visible. Click “Continue to edit picture. 

 
FIG 12 

Click on “Resize Your Picture” and select “Custom Size” from the drop-down list 

https://picresize.com/t
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FIG 13 

13.1 Type 1200 (pixels) in the Height Box. Click outside the box. If the “Estimated Value” now shows a value of more than 1920 as 

width, go to 13.2. Otherwise go to 13.3. 

13.2 Delete the “1200” and type 1920 in the Width box. The height in the “Estimated Value” box should now be 1200 or less. Go to 

the next stage (13.3). 

13.3 Choose “Good” 
13.4 Click “I’M DONE. RESIZE MY PICTURE” 

 
FIG 14  

Choose “Save to disk”. The image will probably be saved by default in your “Downloads” folder. 

 
4C: A SIMPLE AND FREE WAY TO RESIZE IMAGES USING MICROSOFT’S “PHOTOS” APP. 

 

ALWAYS WORK ON A COPY OF THE ORIGINAL IMAGE 

 

Right click on the image and in the menu that appears click “Open With→ Photos”. See Fig 15 

 
FIG 15 
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FIG 16 

Right-click in the image and from the menu that appears, left-click on “Resize” 

 
FIG 17 

On the next menu, click “Define Custom Dimensions” 

 
FIG 18 

 

 

 

 

 

  

In the box that appears: 

1 Tick Maintain aspect ratio 
2 Set Quality to 100% 

3 Replace the existing width value 

with 1920. If the height changes to 

1200 or less, click “Save resized 

copy” BUT 

4 If the height changes to 1201 or 

more, overwrite the height with 

1200. The width will change to 1920 

or less.  

5 Click “Save resized copy” 
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FIG 19 

In the dialogue box that appears, decide where to save it. You’ll notice the new dimensions here.  

EITHER the width will be exactly 1920 and the height 1200 or less 

OR the height will be exactly 1200 and the width 1920 or less 

 

 

 

 
Resizing images using Photoshop (Simple way and Advanced way) – see next page. 
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Resizing images using Photoshop (Simple way and Advanced way). 

 

4D: THE SIMPLE WAY 

ALWAYS WORK ON A COPY OF THE ORIGINAL IMAGE 
 

  
FIG 20          FIG 21 

File → Automate → Fit image      In the dialogue box which appears, type 1920 in the “Width” box 

         and 1200 in the “Height” box. The image will be resized correctly. 

 
4E: THE ADVANCED WAY (for more fine control of the result) 

ALWAYS WORK ON A COPY OF THE ORIGINAL IMAGE 
 

  
FIG 22       FIG 23 

Image → Image size.  

 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 
 

 

In the dialogue box which appears: 

1. Ensure “pixels” is selected from the “Dimensions” 

drop-down box. 

2. If the image is in “Landscape” format, enter “1920” 

in Width box. The “Height” will then adjust 

automatically. If the height adjusts to a value 

greater than 1200, then go straight to point 3. 
3. If the image is in square or “Portrait” format, enter 

“1200” in Height box. The “Width” will then adjust 

automatically. If the width adjusts to a value greater 

than 1920, then go back to point 2. 

4. Ensure “Resample” is ticked. 

5. Most members use the default “Automatic” setting 

of this box.  

6. However, you may prefer to carry out some 

research to determine if one of the other options in 

the drop-down list would be more suitable for you. 

7. Click “OK” 
8. Save the image at the highest quality, making sure 

you don’t overwrite the original. 

 

 


